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 AN4529
 PolarFire SoC FPGA H.264 Video Streaming Over Ethernet

Application Note

Introduction  (Ask a Question)

This application note describes how to run H.264 video streaming over the Ethernet demo. This solution is developed
on PolarFire® SoC FPGA video kit, which features an MPFS250T PolarFire SoC device. Microchip's PolarFire
SoC devices combine RISC-V based 5x core Microprocessor Subsystem (MSS) capable of running Linux® and the
PolarFire Fabric in a single device. This combination enables the partitioning of user designs between the MSS (C
Source code) and Fabric (RTL). Microchip's Libero® SoC enables the rapid development of RTL based designs for
PolarFire SoC and many other device families. Libero SoC provides a wide range of IPs for a variety of applications
such as video and imaging, signal processing, wired and wireless communications, and networking. Microchip's
SoftConsole enables the rapid development of the C/C++ source code-based applications targeted for all Microchip
FPGA and SoC device families.

The demo design captures live stream from a camera on the PolarFire SoC video kit and performs H.264
compression in the fabric logic. Webserver application running on MSS allows user to connect to the PolarFire SoC
video kit through Ethernet using the IP address of the kit from the web browser. The web page on the browser allows
user to control streaming of the live video from PolarFire SoC video kit to the connected system. On initiating the
streaming from the web page, application triggers MSS that reads compressed stream of data from fabric and sends
encoded H.264 RTP Ethernet packets with the IP address of the system from which the stream request was initiated.
User can play the video on computer using VLC Player, Gstreamer, or FFPlay applications. Web page allows user to
download and pass the SDP file to the video player application after streaming is initiated.

PolarFire SoC FPGA video kit enables prototyping of Video and Imaging solutions. The kit supports the following key
features among others:

• MPFS250T PolarFire SoC FPGA device
• MIPI CSI-2 interface
• FPGA Mezzanine Card (FMC) connector
• SD and eMMC card, LPDDR4, and DDR4 memories
• HDMI, Ethernet, PCIe®, and other interfaces
• CAN, WIFI, and mikroBUS

For more information about the video kit, see MPFS250-VIDEO-KIT.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-7AC0506C-F0E4-40E5-982B-643BDB788DC2&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Introduction
https://www.microchip.com/en-us/development-tool/MPFS250-VIDEO-KIT
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1. Design Overview  (Ask a Question)

The following figure shows the high-level block diagram of the reference design.

Figure 1-1. High-level Block Diagram
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The camera generates a live Full HD image (1920x1080 picture resolution) in the Bayer format at 30 FPS. The FPGA
fabric receives these frames and performs processing as follows:

• IMX334 top block contains MIPI CSI2 Rx IP to get the camera data, which is passed to the Bayer Interpolation
IP. This IP block converts each Bayer frame to RGB data format. Specifically, each single 8-bit Bayer pixel data
is converted to a 24-bit RGB pixel. 

• The 24-bit RGB pixel data is then passed through Image Processing IPs to add features like auto-brightness,
R/G/B gains, contrast, and so on.

• The On Screen Display (OSD) logic injects the text "COMPRESSION RATIO x" into the image frame. Where the
x is the value of compression ratio input from software. Each character size is 16x16 pixels. The text characters
and digits in 16x16 pixel format are stored in the ROM. The OSD logic injects the text at the location specified by
the coordinates input from software. The text color can also be controlled by using the color input of OSD logic.
However, software is yet to support the color interface. The OSD logic takes RGB as the input frame format and
gives RGB frame with the injected text in the specified coordinates as the output.

• RGB data is converted to YUV422 format using RGB to YUV convert IP.
• 1920x1080 image is scaled down to the selected resolution using Image Scaler IP and sent to H.264

Compression IP. The resolution can be changed from the user application. The APB registers are accessed
from FIC3 Master Interface.

• The H.264 compressed data is written to the LPDDR memory through FIC1 AXI slave interface.
• Application running on MSS reads the compressed data from the LPDDR4 memory.
• On Linux, Fast Forward MPEG (FFMPEG) reads FIFO data and generates RTP packets to send over GEM.

RGB Gains, Compression quality factor, Compression Resolution, Contrast, Brightness, and so on are controlled by
MSS through FIC3 Master interface.

1.1 IP Blocks  (Ask a Question)

The following table lists the IP blocks used in the design and their functionality.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-28414A40-3F95-4AF9-9074-07630FDC525E&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Design%20Overview
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-3B2201B6-55AA-4E26-9ACF-C7F9CFA9E17B&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=IP%20Blocks
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Table 1-1. IP Blocks

IP Block Description

PF_OSC The PolarFire® RC Oscillator block generates a 2 MHz clock.

PF_CCC The PolarFire CCC block generates multiple clocks in the design.

Clock divider The clock divider block divides by two configurations.

H.264 The H.264 block performs H.264 compression on YUV4:2:2 data input.

mipicsi2rxdecoder

The MIPI CSI-2 receiver decoder block for PolarFire (MIPI CSI-2 RxDecoder) decodes
the data from the sensor interface.
g_DATATYPE: RAW10

g_LANE_WIDTH: 4

g_NUM_OF_PIXELS: 1

g_INPUT_DATA_INVERT: 0

g_FIFO_SIZE: 12

PF_IOD_Generic_RX The IP block operates with 500 Mbps data rate.

CoreReset The IP block synchronizes the reset to the respective clock domain.

MSS_VIDEO_KIT

On the MSS hard IP, the Linux user space application receives the H.264 compressed
frame from fabric FIFO and streams over Ethernet.

For more information about the MSS configuration and LPRDDR4 memory partitioning,
see 1.2.  MSS Configuration. 

Core AXI4 Interconnect
Single Master with 64-bit data width and Single Slave with 64-bit data width. The Slave
is configured with 0xE000_0000 start and 0xE003_FFFF end addresses. Here, the AXI4
master is reading the video data from AXI4 Slave FIFO.

Bayer This IP block converts the 8-bit raw data to 24-bit RGB data and forwards it to the
Gamma Correction IP.

RGBtoYCbCr_C0 This color space conversion IP block converts OSD RGB 24-bit data format to YUV422
16-bit data format.

Gamma_Correction_C0 This IP block converts the pixel intensity to match with the perspective of human eye by
using a logarithmic curve.

Image_Enhancement_C0 This IP block adjusts the brightness, contrast, and color balance through user controls.

IMX334_IF_TOP This SmartDesign module receives the live camera feed and converts it into raw 8-bit
parallel data. Each byte represents one pixel.

INIT MONITOR The IP block triggers reset to the design.

1.2 MSS Configuration  (Ask a Question)

The following table lists the configuration of MSS clock, peripherals, and memory.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-C44AA5C0-BF01-4DDD-9B16-E91942FD172F&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=MSS%20Configuration
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Table 1-2. MSS Blocks

MSS Block Description

MSS Clocks
MSS PLL reference clock source: 125 MHz

MSS CPU clock frequency: 600 MHz

Peripherals

• eMMC: Used for storing Linux kernel images.
• Gigabit Ethernet MAC: Used for copying data to/from the Linux OS to Host PC.
• MMUART: Used to capture HSS boot log and Linux terminal.
• I2C: Used for initializing the camera.
• Fabric Interface Controller (FIC1) AXI4 Slave interface for LPDDR access from fabric.
• Fabric Interface Controller (FIC3) APB Master interface for register access.

DDR Memory LPDDR4 with the default configuration.

Memory Partitioning See 1.2.1.1.  DDR Memory Partition.

1.2.1 DDR Memory Mappings  (Ask a Question)

This section describes the DDR regions and their allocations. It also explains how these memory regions are defined
in the Linux device tree so that the Linux user space can address these regions.

For more information about DDR memory partition regions, see the “Segmentation Blocks” section in PolarFire SoC
MSS Technical Reference Manual.

1.2.1.1 DDR Memory Partition  (Ask a Question)

The following figure shows the memory mapping of the 2 GB on-board DDR memory in the Linux device tree.

Figure 1-2. LPDDR4 Memory Mapping
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PolarFire SoC video kits come with 2 GB of DDR memory by default, partitioned as follows:

• 1.92 GB (1.88 GB + 32 MB) is allocated to higher cached memory.
– 1.88 GB at higher address space.
– 32 MB at lower address space.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-F2B4C6FA-25D5-4CC2-A1F0-9A0ED6E6BEA8&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=DDR%20Memory%20Mappings
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ReferenceManuals/PolarFire_SoC_FPGA_MSS_Technical_Reference_Manual_VC.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ReferenceManuals/PolarFire_SoC_FPGA_MSS_Technical_Reference_Manual_VC.pdf
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-A220B514-620A-4B1C-B023-AF9618D05561&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=DDR%20Memory%20Partition
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• 128 MB is allocated to non-cached memory. This region is addressable with or without Write Combining Buffer
WCB.

The following figure shows the MSS Configurator > DDR Memory Partition settings used in the design.

Figure 1-3. DDR Memory Partition

1.2.1.2 Linux Device Tree Memory Mapping  (Ask a Question)

The following table lists the memory regions defined in the Linux device tree, as per the PolarFire SoC video kit. For
more information about the PolarFire SoC memory mapping, see the “MSS Memory Map” section in PolarFire SoC
MSS Technical Reference Manual.

Table 1-3. DDR Memory Regions and Sizes for MPFS250-VIDEO-KIT

Region Name Region Base Region Size Region Properties

DDRC-LO 0x80000000 32 MB 32-bit address, cached

DDR-NC-LO 0xC0000000 128 MB 32-bit address, non-cached

DDR-NC-WCB-LO 0xD0000000 128 MB 32-bit address, non-cached, write-combine buffer

DDRC-HI 0x1000000000 1.88 GB 64-bit address, cached

Important: The 128 MB is a shared view of a single physical memory area.

The memory regions listed in the preceding table are mapped in the Linux device tree as follows.

• The 1.88 GB DDR-C is mapped at 0x10_0000_0000. The following .dts stanzas define these mappings. 

ddrc_cache: memory@1000000000 {
  device_type = "memory";
  reg = <0x10 0x0 0x0 0x76000000>;
  status = "okay";
         };

• The remaining 160 MB of memory for other purposes is allocated into the following three buffers of reserved
memory in the 32-bit address space (LO):

– 32 MB buffer, cache-coherent
– 64 MB buffer, non-cache-coherent
– 64 MB buffer, non-cache-coherent, write combine buffered

These three buffers are defined in the device tree (.dts) file in the following reserved-memory stanzas.

 reserved-memory {
 ranges;
 #size-cells = <2>;
 #address-cells = <2>;
 fabricbuf0ddrc: buffer@80000000 {
   compatible = "shared-dma-pool";

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-03FA0159-B5C9-4A79-BD14-2F511E28AB7D&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Linux%20Device%20Tree%20Memory%20Mapping
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ReferenceManuals/PolarFire_SoC_FPGA_MSS_Technical_Reference_Manual_VC.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/ReferenceManuals/PolarFire_SoC_FPGA_MSS_Technical_Reference_Manual_VC.pdf
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   reg = <0x0 0x80000000 0x0 0x2000000>;
   no-map;
  };
   fabricbuf1ddrnc: buffer@c4000000 {
   compatible = "shared-dma-pool";
   reg = <0x0 0xc4000000 0x0 0x4000000>;
   no-map;
  };
 fabricbuf2ddrncwcb: buffer@d4000000 {
   compatible = "shared-dma-pool";
   reg = <0x0 0xd4000000 0x0 0x4000000>;
   no-map;
  };
 };

Important: The reserved-memory stanza must be at the top-level of the device tree file (.dts) for the
Linux subsystem to pick.

To access this reserved memory from the Linux user space, device driver named u-dma-buf by Ichiro Kawazome is
used. It allocates contiguous memory blocks in the kernel space as DMA buffers and makes them available from the
user space.

1.3 I/O Ports  (Ask a Question)

The following table lists the key I/O ports in the design.

Port Name Direction Description

Camera RX, Reset, and Reference Clock Ports

CAM1_RST Input Input signal used to reset the camera sensor module. This signal
comes from the MSS.

CAM1_RX_CLK_P

CAM1_RX_CLK_N
Input Input pads to receive the reference lock for the camera sensor.

CAM1_RXD[0]

CAM1_RXD_N[0]

CAM1_RXD[1]

CAM1_RXD_N[1]

CAM1_RXD[2]

CAM1_RXD_N[2]

CAM1_RXD[3]

CAM1_RXD_N[3]

Input Input pads to receive the live video from the camera sensor module.
These pads are assigned to the Bank 7 I/Os. 

MSS Peripheral Ports

REFCLK

REFCLK_N
Input Input ports for receiving MSS reference clock from the on-board 125

MHz oscillator.

RESET_N Output This port is assigned to AB12 pin of Bank 6 MSS DDR. This port is
used to reset the on-board LPDDR4.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-EE7FB28E-DC4A-49FE-8A4E-0FA57D9C0123&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=I%2FO%20Ports
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...........continued
Port Name Direction Description

MMUART_0_RXD_F2M

MMUART_0_TXD_M2F

MMUART_1_RXD_F2M

MMUART_1_TXD_M2F

Input and Output Input and Output ports assigned to C7, B7, D4, and C4 pins. These
pins are connected to the on-board CP2108 USB to UART chip.

USB_CLK Input USB clock from the on-board USB3340-EZK-TR IC.

USB_DATA0

USB_DATA1

USB_DATA2

USB_DATA3

USB_DATA4

USB_DATA5

USB_DATA6

USB_DATA7

Inout USB data ports assigned to Bank 2 MSS I/Os.

EMMC_CLK Output This port is assigned to AA8 pin of the Bank 4 to provide clock to the
eMMC device.

EMMC_CMD Inout This port is assigned to AA9 pin of Bank 4 to receive and forward
eMMC commands.

EMMC_DATA0

EMMC_DATA1

EMMC_DATA2

EMMC_DATA3

EMMC_DATA4

EMMC_DATA5

EMMC_DATA6

EMMC_DATA7

Inout eMMC data ports assigned to Bank 4 MSS I/Os.

SDIO_SW_EN_N Output Enable Secure Digital Input Output (SDIO) port.

SDIO_SW_SEL0

SDIO_SW_SEL1
Output SDIO selection pin.

SGMII_RX0_N

SGMII_RX0_P
Input Input ports assigned to Bank 5 W1 and Y1 pins (MSS I/Os). These pins

are connected to the on-board VSC8662 PHY device.

SGMII_TX0_N

SGMII_TX0_P
Output Output ports assigned to Bank 5 Y5 and AA5 pins (MSS I/Os). These

pins are connected to the on-board VSC8662 PHY device.

Transceiver Ports

REF_CLK_PAD_N_0

REF_CLK_PAD_P_0
Input

Inputs ports for receiving the transceiver reference clock. These ports
are assigned to AF29 and AF30 pins, which are connected to the
on-board 148.5 MHz oscillator.
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...........continued
Port Name Direction Description

LANE0_TXD_N

LANE0_TXD_P

LANE1_TXD_N

LANE1_TXD_P

LANE2_TXD_N

LANE2_TXD_P

LANE3_TXD_N

LANE3_TXD_P

Output Transceiver TX lanes connected to HDMI TX interface.

LED2

LED3
Output GPIOs connected to on-board user LEDs.

1.4 Clocking Structure  (Ask a Question)

The following figure shows the clocking structure of the design.

Figure 1-4. Clocking Structure
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• PF_CCC generates the following fabric clocks from the 50 MHz on-board reference clock.
– OUT0_FABCLK_0 (125 MHz): This clock is used to drive the FIC1 and AXI IF clocks.
– OUT1_FABCLK_0 (50 MHz): This clock is used to drive the FIC3 and APB3 bus interface.

• The on-board 27 MHz Oscillator on the camera module is used as a reference clock for IOD in the IMX334
block. The CCC inside the IMX334 uses reference clock from IOD and generates 170 MHz clock.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-76BE74E2-4F24-4294-9B26-B58814608A80&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Clocking%C2%A0Structure
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1.5 Reset Structure  (Ask a Question)

The following figure shows the reset structure of the design.

Figure 1-5. Reset Structure
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The INIT_MONITOR IP asserts the following signals:

• FABRIC_POR_N: This signal is asserted after the initialization of the fabric. FABRIC_POR_N is used to reset
the MSS.

• DEVICE_INIT_DONE: This signal is asserted after the initialization of the entire PolarFire SoC device.

After asserting the FABRIC_POR_N, DEVICE_INIT_DONE, and MSS_RESET_N_M2F, the CORERESET_PF IP
blocks generate the Reset signals.

1.6 Resource Utilization  (Ask a Question)

The following figure shows the resource utilization of the design.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-FDA7CA94-B318-4115-A621-7D4DA8C4C79D&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Reset%20Structure
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-781F2D80-C075-490E-8C99-6FB959D16AD6&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Resource%20Utilization
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Figure 1-6. Resource Utilization
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2. Demo Requirements  (Ask a Question)

The following table lists the hardware and software required for running the demo.

Table 2-1. Demo Requirements

Requirement Description

Hardware and Accessories

PolarFire® SoC video kit MPFS250-VIDEO-KIT

Image Sensor Module LI-IMX334-MIPI-MICRO v1.0

USB A to micro-B cable
Required for:

• FPGA programming
• UART interface for the terminal prompt from Linux®

Power adapter 12V, 5A

Host PC
• A host PC with USB and Ethernet port
• Windows® 10 and above, or Ubuntu 20.04

Ethernet cable To communicate with the video kit while using the web GUI.

Utility Software

FPExpress FPGA Programming application

MobaxTerm, Putty, or TeraTerm UART receiver-transmitter application at the host PC.

USBImager Free utility used for flashing binary images to USB sticks or SD/CF cards.

7-zip Free archiving utility for compressing/decompressing files and is needed for
extracting .wic file from .wic.gz.

Admin privileges Flashing Linux .wic images using USBImager requires admin privileges.

VLC Media Player
• 3.0.16 (Windows) and above or 3.0.9.2 (Ubuntu) and above
• To play the H.264 video

Web Browser Chrome 96.0.4664.110 (Official Build) (64-bit) and above, or Microsoft Edge
Version 96.0.1054.53 (Official build) (64-bit) and above

Flashable Binaries

Linux wic image core-image-minimal-dev-mpfs-video-kit-xxxx.rootfs.wic.gz
Job file VKPFSOC_H264.job

The name of the binaries mentioned in the preceding table may be different from the rest of the guide as these keep
changing in each releases but the flashing and demo procedures remain the same.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-261306CF-F1BA-439F-9A4E-E21E84D6ABD6&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Demo%20Requirements
https://mobaxterm.mobatek.net
https://www.putty.org
https://download.cnet.com/Tera-Term/3000-2094_4-75766675.html
https://bztsrc.gitlab.io/usbimager/
https://www.7-zip.org/download.html
https://www.videolan.org
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3. Demo Prerequisites  (Ask a Question)

Before you start:

1. Download the Programming Job File.
2. Download the Linux .wic image.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-5055A3BB-6278-40FC-9E3B-66991F02D6E3&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Demo%20Prerequisites
https://github.com/polarfire-soc/polarfire-soc-video-kit-reference-design/releases/tag/v2023.02
https://github.com/polarfire-soc/meta-polarfire-soc-yocto-bsp/releases/download/v2023.02/core-image-minimal-dev-mpfs-video-kit-20230223223647.rootfs.wic.gz
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4. Setting Up the Demo  (Ask a Question)

The demonstration involves the following steps:

• 4.1.  Setting Up the Hardware
• 4.2.  Setting Up the Serial Terminal
• 4.3.  Programming the Device

4.1 Setting Up the Hardware  (Ask a Question)

Setting up the hardware involves interfacing the camera sensor module and the HDMI monitor with the PolarFire SoC
video kit.

Follow these steps:

1. Connect the camera sensor module at J10 on the video kit.
2. Ensure the jumper settings on the video kit are set as per the “Jumper Settings” section in PolarFire SoC

FPGA Video Kit User Guide.

4.2 Setting Up the Serial Terminal  (Ask a Question)

PolarFire SoC Video kit includes CP2108 USB to UART chip to interact with on-board Linux OS. Before you start:
• Download and install CP210x Universal Windows Driver.
• Unzip and see the CP210x_Universal_Windows_Driver_ReleaseNotes.

After installing the driver, follow these steps:

1. Connect USB cable at J12 port on the PolarFire SoC video kit board to the host PC.
2. After connecting the power adapter to the board at J39, switch ON the boards power supply using the

SW5 switch. This must detect the USB UART chip on the board at the host PC. You can confirm this at the
host PC device manager, see the following figure.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-0A70F7BF-C63D-4E67-B9ED-6FE2D6C21F06&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Setting%20Up%20the%20Demo
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-0D8F512D-B156-4ED4-AE5B-EC5B9DCE84A5&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Setting%20Up%20the%20Hardware
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_SoC_FPGA_Video_Kit_User_Guide.pdf
https://ww1.microchip.com/downloads/aemDocuments/documents/FPGA/ProductDocuments/UserGuides/PolarFire_SoC_FPGA_Video_Kit_User_Guide.pdf
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-95927583-4EEB-4F25-8978-84177CAE194E&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Setting%20Up%20the%20Serial%20Terminal
https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers
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Figure 4-1. Device Manager

The interfaces on the host PC's device manager are active in the current demo project and display the
messages when appropriately configured.

Interface 0 displays the Hart Software Service (HSS) boot messages while Interface 1 displays U-Boot
messages, Linux boot messages, and provides a Linux prompt.

Important: For each user, the interfaces might be on a different COM# than what is shown in the
preceding figure.

An application like MobaXterm/TeraTerm at the host PC is required to establish serial communication with the
video kit board. The baud rate for such connections must be 115200 bps, see the following figure.
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Figure 4-2. Serial Port Settings

3. Open Interface 0 and Interface 1.

Important: The data rate must be configured for all interfaces to establish successful communication with
the PolarFire SoC video kit.

4.3 Programming the Device  (Ask a Question)

This section describes the steps to program the PolarFire SoC device with the VKPFSoC_H264.job file using
FlashPro Express.

Follow these steps:

1. Ensure to close pins 1 and 2 of J28 jumper.
2. Connect a micro-USB to J5 from the host PC and start the FPExpress software from Windows > Start.
3. Ensure to power on the PolarFire SoC video kit.
4. Select New or New Job Project from the Project menu to create a new job project, see the following figure.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-07CB47D4-6E4B-4E96-AABB-A127DDE2854F&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Programming%20the%20Device
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Figure 4-3. New FlashPro Express Project

5. In the New Job Project dialog box, enter the following:
– Programming job file: Click Browse and navigate to the location where the job file is located and select

the file.
– FlashPro Express job project location: Select Browse and navigate to the location where you want to

save the project.
6. Click Open. The required programming file is selected and ready to be programmed in the device. The

FlashPro Express window appears. Confirm that a programmer number appears in the Programmer field. If it
does not, check the board connections and click Refresh/Rescan Programmers.

7. Click RUN to program the device. When the device is programmed successfully, a RUN PASSED status is
displayed.

8. Close FlashPro Express (Project > Exit).
9. Power-cycle the board.
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5. Running Linux User Applications  (Ask a Question)

The Linux .wic image is packaged with all the demo applications. Extract the core-image-minimal-dev-mpfs-
video-kit-xxxx.rootfs.wic.gz with 7zip utility to any folder. The extracted  core-image-minimal-dev-
mpfs-video-kit-xxxx.rootfs.wic image can be flashed either in eMMC or SD card. Irrespective of the
flashing device, running the demo user applications remain the same.

Important:  If the Linux image has multi-compression extensions like wic.gz.zip, extract till .wic is
obtained.

5.1 Flashing Linux .wic Image in eMMC Mode  (Ask a Question)

This section describes the steps to put the HSS in CLI mode, program the Linux images into eMMC using the
USBImager application and initiate the Linux boot.

1. Do not insert SD card to the board. If present, SD card booting takes priority.
2. Remove the micro-USB cable connected to J5 and connect it to J19  (USB-OTG connector) of the board.

When the USB cable is detected, the LED near J19 glows in green.
3. Connect one more micro-USB cable to J12 from the host PC.
4. J18 and J57 must be open.
5. Close pins 2 and 3 of J36.
6. Power ON the board and press Enter on Interface 0 while booting.

Important: The COM port number might be different for different users. To identify the COM port,
see 4.2.  Setting Up the Serial Terminal.

7. Follow the steps in eMMC Content Update Procedure.
8. After programming the eMMC and rebooting, check the serial terminal application connected to Interface 1.

Linux will be up and running, waiting for user to login.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-4B409D7F-ECAD-4CEE-8D2D-DCA42394C68F&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Running%20Linux%20User%20Applications
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-15C432B5-5B1F-42F1-B01C-F6918E646917&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Flashing%20Linux%20.wic%20Image%20in%20eMMC%20Mode
https://mi-v-ecosystem.github.io/redirects/polarfire-soc-documentation-updating-mpfs-kit-programming-a-linux-image
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Figure 5-1. Linux User Login

This step demonstrated the process of running the Linux user application by programing the Linux user application
image onto the on-board 8 GB eMMC NAND Flash using the .wic file. Upon completion the Linux OS booted up
successfully from the eMMC as indicated by the Linux OS login prompt displayed to the user.

5.2 Flashing Linux .wic Image in SD Card Mode  (Ask a Question)

This section describes the steps to program the Linux images into SD card using the SD card reader and USBImager
application, and initiate the Linux boot.

Important: This step is required only to boot from SD card instead of on-board 8 GB eMMC NAND Flash.
Skip this step to boot the Linux from eMMC Flash and run the demo.

1. Power OFF the board.
2. Follow the steps in SD Card Content Updated Procedure.

5.3 Running the H.264 Demo using GUI  (Ask a Question)

To run the H.264 demo using GUI, follow these steps:

1. Insert the dual-camera sensor module in J10 on the PolarFire SoC video kit. Ensure to remove the camera
lens cap.

2. Do not connect any Ethernet cable from the host to the video kit.
3. On the windows host, open command prompt in Admin mode and type ipconfig.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-D358CBCD-023B-4BF3-B474-4969610B8361&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Flashing%20Linux%20.wic%20Image%20in%20SD%20Card%20Mode
https://mi-v-ecosystem.github.io/redirects/polarfire-soc-documentation-updating-mpfs-kit-programming-a-linux-image
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-15CFD4ED-08CF-49D4-B60A-529E5C2E1710&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Running%20the%20H.264%20Demo%20using%20GUI
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Figure 5-2. Executing the ipconfig Command

4. Make a note of the Ethernet adapter name displayed against the Media disconnected interface. It is Ethernet
in this case.

5. Set the host IP address to 192.168.2.X, where X is any integer from 2 to 255 and the Subnet mask to
255.255.255.0 using the following command. This is a one-time process and need not to be done every time
the video kit is connected.
netsh interface ip set address "Ethernet" static 192.168.2.100 255.255.255.0

Figure 5-3. Setting the Host IP Address

6. Connect an Ethernet cable from video kit eth0 port to the PC Ethernet port. There are two Ethernet ports on
the video kit. The Ethernet port eth0 is next to the camera mount.

7. Power ON the board and wait for the system boot sequence to complete. The LED highlighted (LED 3) in the
following figure glows green once the Linux boot up sequence is completed.

8. Restart the board if LED 3 does not glow.
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Figure 5-4. PolarFire SoC Video Kit—LED Indication

9. Log in to Linux using the user name root (password is not required).
10. To configure the board for static IP, follow the steps mentioned in Steps to configure static IP addresses.
11. Reboot the video kit and log in again into Linux using the user name root.
12. Type ifconfig, on the serial terminal connected to Interface 1 (Linux COM Port).
13. It must report some IP, which indicates that the Ethernet port is working, see the following figure.

https://mi-v-ecosystem.github.io/redirects/polarfire-soc-documentation-video-kit-demo-configure-static-ip


 AN4529
Running Linux User Applications

© 2023 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004529B-page 22

Figure 5-5. Fetching the Ethernet Port Status

14. Check if the connection is successful by pinging the video kit, see the following figure.
Figure 5-6. Pinging the Video Kit

15. From the host PC, open the web browser. Enter the IP address of the PolarFire SoC video kit, depending on
the Gigabit Ethernet MAC (GEM) you are connected to (J6: 192.168.2.1 or J7: 192.168.2.2), in the address
bar and press Enter. The H.264 demonstration GUI loads in the browser, see the following figure.
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Figure 5-7. H.264 GUI

16. Click the Start Video to initiate the video streaming. The GUI creates a Session Description Protocol (SDP)
file. VLC player uses this to accept streaming packets from the Ethernet cable.

– Click Download SDP file to download the SDP file.
– Windows®: Open the SDP file with the VLC player to play the video stream.
– Linux: Open the SDP file with the VLC player or execute the vlc command in the terminal, with the SDP

file as argument, for example, vlc video.sdp.
17. Observe a live stream video captured from one of the cameras in the PolarFire SoC video kit. This is a scaled

and H.264 compressed video of 1280x720 resolution. To change the resolution, select the resolution as shown
in the following figure and click Update.
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Figure 5-8. Select Resolution

18. Observe the live stream video in the VLC player, as shown in the following figure. Adjust the VLC
configurations to reduce the lag in streaming. For more information about VLC configurations, see
6.  Appendix A: VLC Configurations.
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Figure 5-9. Live Stream Video

This concludes the demo.

To get back from static to DHCP (dynamic), use the below command in the Windows command-line prompt:

netsh interface ip set address name="Ethernet" dhcp
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6. Appendix A: VLC Configurations  (Ask a Question)

Launch the VLC player and configure the following for H.264 streaming.

1. Disable the hardware acceleration.
a. On the VLC media player menu bar, select Tools > Preference.
b. In the Simple Preferences window, click the Input / Codecs tab and set the Hardware-accelerated

decoding as Disable.
Figure 6-1. Simple Preference—Input / Codecs

2. Alter the Network Caching.
a. In the VLC media player menu bar, select Tools > Preference.
b. Select All under Show settings for Advanced Preferences.
c. In the Advanced Preferences window, select Input / Codecs and alter the Network Caching (ms) if

the file you are trying to play is located on a network share. Increasing the Network Caching (ms) value
increases the latency of video playing in VLC.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-83E20103-2F74-4E28-B92E-368F25190893&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Appendix%20A%3A%20VLC%20Configurations
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Figure 6-2. Advanced Preferences—Input / Codecs

3. Configure the FFMPEG Video Decoder Parameters.
a. Select Input / Codecs > Video codecs > FFmjpeg.

i. Clear Direct rendering.
ii. Select Allow speed tricks and set Skip the loop filter for H.264 decoding to None.
iii. Set Threads to 2.
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Figure 6-3. Advanced Preferences—Video Codecs

4. Configure the video output module.
a. Select Video > Output modules and set Video output module as Windows GDI video output.

Figure 6-4. Advanced Preferences—Video Output Modules

5. Click Save.
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7. Appendix B: Running the Tcl Script  (Ask a Question)

Tcl scripts are provided in PolarFire SoC Video Kit Reference Design.

To run Tcl, follow these steps:

1. Launch the Libero software
2. Select Project > Execute Script....
3. Click Browse and select MPFS_VIDEO_KIT_REFERENCE_DESIGN.tcl from the downloaded TCL_Scripts

directory.
4. Add any required arguments (for example, HSS_UPDATE PROGRAM)
5. Click Run.

After successful execution of the Tcl script, the Libero project is created within the top directory.

Important: The H.264 I-Frame Encoder Encrypted IP is Licensed. If the license is not available, the Tcl
generates the design with an Evaluation license which expires after an hour’s use on the hardware. So,
the streaming stops after an hour.

For more information about Tcl scripts, see readme.md.

See Tcl Commands Reference Guide for more information about Tcl commands. Contact Technical Support for any
queries about running the Tcl script.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-BACE21BE-6973-4D42-BC76-B50A5CC39D38&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Appendix%20B%3A%20Running%20the%20Tcl%20Script
https://github.com/polarfire-soc/polarfire-soc-video-kit-reference-design
http://coredocs.s3.amazonaws.com/Libero/2023_1/Tool/libero_soc_tcl_cmd_ref_ug.pdf


 AN4529
Revision History

© 2023 Microchip Technology Inc.
and its subsidiaries

 Application Note DS00004529B-page 30

8. Revision History  (Ask a Question)

Revision Date Description

B 03/2023 • Replaced all instances of “SEV” with “Video” throughout the document.
• Updated for Libero SoC v2022.3.
• Added reference to GitHub for programming a Linux® image on the on-board eMMC

and SD Card. See 5.1.  Flashing Linux .wic Image in eMMC Mode and 5.2.  Flashing
Linux .wic Image in SD Card Mode.

A 04/2022 The first publication of this document.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-26366DFE-FE0F-4F1A-AFC6-B1438F4C3608&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Revision%20History
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Microchip FPGA Support  (Ask a Question)

Microchip FPGA products group backs its products with various support services, including Customer Service,
Customer Technical Support Center, a website, and worldwide sales offices. Customers are suggested to visit
Microchip online resources prior to contacting support as it is very likely that their queries have been already
answered.

Contact Technical Support Center through the website at www.microchip.com/support. Mention the FPGA Device
Part number, select appropriate case category, and upload design files while creating a technical support case.

Contact Customer Service for non-technical product support, such as product pricing, product upgrades, update
information, order status, and authorization.

• From North America, call 800.262.1060
• From the rest of the world, call 650.318.4460
• Fax, from anywhere in the world, 650.318.8044

Microchip Information  (Ask a Question)

The Microchip Website  (Ask a Question)

Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service  (Ask a Question)

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support  (Ask a Question)

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature  (Ask a Question)

Note the following details of the code protection feature on Microchip products:

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-98F6498F-0C2F-4D7F-87F6-A792AFD2A286&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Microchip%20FPGA%20Support
http://www.microchip.com/support
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-0FB3F908-88EE-45CE-94F5-E97AF9049C9B&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Microchip%20Information
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-7551DC67-D79D-4F0C-B56F-7B17E12400E0&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=The%20Microchip%20Website
https://www.microchip.com/
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-CDA512D8-0DE4-4672-8716-04CAC681CB38&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Product%20Change%20Notification%20Service
https://www.microchip.com/pcn
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-F05182E4-B102-4775-A746-1FF37F465312&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Customer%20Support
https://www.microchip.com/support
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-E8251634-7B15-4073-A103-5A5F128B8699&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Microchip%20Devices%20Code%20Protection%20Feature
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• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice  (Ask a Question)

This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.

Trademarks  (Ask a Question)

The Microchip name and logo, the Microchip logo, Adaptec, AVR, AVR logo, AVR Freaks, BesTime, BitCloud,
CryptoMemory, CryptoRF, dsPIC, flexPWR, HELDO, IGLOO, JukeBlox, KeeLoq, Kleer, LANCheck, LinkMD,
maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST, MOST logo, MPLAB, OptoLyzer,
PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer, QTouch, SAM-BA, SenGenuity, SpyNIC, SST,
SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are
registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, Flashtec, Hyper Speed
Control, HyperLight Load, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
ProASIC Plus logo, Quiet- Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider,
TrueTime, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, Clockstudio, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion,
CryptoController, dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S,
EtherGREEN, GridTime, IdealBridge, In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, IntelliMOS,
Inter-Chip Connectivity, JitterBlocker, Knob-on-Display, KoD, maxCrypto, maxView, memBrain, Mindi, MiWi, MPASM,
MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, RTAX, RTG4, SAM-

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-125F1A93-76CC-4BD7-BACA-01844FBD5F4F&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Legal%20Notice
https://www.microchip.com/en-us/support/design-help/client-support-services
https://www.microchip.com/en-us/support/design-help/client-support-services
https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-21750586-F9F2-4E33-87FB-8F2994BF4744&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Trademarks
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ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SmartHLS, SMART-I.S., storClad, SQI, SuperSwitcher,
SuperSwitcher II, Switchtec, SynchroPHY, Total Endurance, Trusted Time, TSHARC, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2023, Microchip Technology Incorporated and its subsidiaries. All Rights Reserved.

ISBN: 978-1-6683-2208-6

Quality Management System  (Ask a Question)

For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.

https://microchipsupport.force.com/s/newcase?pub_guid=GUID-41FEB2F6-C03F-4174-9174-A83D5C533D88&pub_lang=en-US&pub_ver=2&pub_type=Application%20Note&bu=fpga&tpc_guid=GUID-07985EED-D525-413B-AEFE-78B563328687&cover_title=PolarFire%20SoC%20FPGA%20H.264%20Video%20Streaming%20Over%20Ethernet%20Application%20Note&tech_support_link=NA&revision_letter=B&source=PDF&title=Quality%20Management%20System
https://www.microchip.com/quality
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